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Packing List for FTS for Bluetooth (Full 
Version) 
 
*    Bluetooth ComProbe® USB Adapter 
*    USB 3-foot Extension Cable (Can be used with 
Bluetooth ComProbe) 
* Cable Set, containing one Routing Cable, one Monitor 

Head (beige), one Source Head (black), three male 9-pin 
to female 25-pin adapters and one female 9-pin to male 
25-pin adapter 

* This Setup and Quick Start Guide 
* Envelope with Product Registration Card and software 

CD-ROM 
 
Packing List for FTS for Bluetooth (All Trial 
Versions) 
 
*    Bluetooth ComProbe® USB Adapter 
*    USB 3-foot Extension Cable (Can be used with 
Bluetooth ComProbe) 
 
Some Trial Versions also include  
*    Cable Set, containing one Routing Cable, one Monitor 

Head (beige), one Source Head (black), three male  9-pin 
to female 25-pin adapters and one female 9-pin to male 
25-pin adapter 

* This Setup and Quick Start Guide 
* Software CD-ROM 
 
Packing List for SerialBlue 
 
* Cable Set, containing one Routing Cable, one Monitor 

Head (beige), one Source Head (black), three male  9-pin 
to female 25-pin adapters and one female 9-pin to male 
25-pin adapter 

* This Setup and Quick Start Guide 



 

* Envelope with Product Registration Card and software 
CD-ROM 

 
 
System Requirements 
 
Support for all Windows 9x family operating systems is 
being phased out.  Therefore, it is recommended that you 
install FTS for Bluetooth on either a Windows 2000 or 
Windows XP (any version) machine.  Should you install on a 
9x machine and encounter a problem it is highly likely that 
our suggested resolution to the problem will be to switch 
operating systems. 
 
* PC with Windows 2000 or Windows XP and a Pentium 

processor or higher 
* RAM Requirements: 128MB 
* 50 MB free Hard Disk Space (capture file size is only 

limited by disk size) 
 
For Air Sniffing 
* 1 USB Port 
 
For Serial HCI Sniffing 
* Minimum of one COM port, two required for bi-

directional monitoring when using cable set 
* FTS for Bluetooth supports COM1 through COM64 
* Maximum data rate supported is dependent on PC 

processor speed 
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1 Introduction 
 
This Quick Start Guide is for FTS for Bluetooth and 
SerialBlue.  Though we refer to FTS for Bluetooth 
throughout this document, this guide is applicable for 
SerialBlue if you only make use of the sections on Serial 
HCI Sniffing. 
 
FTS for Bluetooth is a PC-based, Bluetooth protocol 
analyzer capable of sniffing Bluetooth data in four ways:  
 

1. Through the air;  
2. From the Serial HCI interface between a 

Bluetooth Host CPU and a Bluetooth Host 
Controller;  

3. From the USB HCI interface between a Bluetooth 
Host CPU and a Bluetooth Host Controller; 

4. By "virtual" sniffing via the product's Live Import 
feature, which permits any application to feed 
data into FTS for Bluetooth.  

 
In this document, Serial HCI Sniffing Mode refers to sniffing 
over the HCI UART (also known as H4), HCI Three-Wire 
UART (also known as H5) and BCSP Transports. 
 
If you have purchased SerialBlue then you have only mode 
2, Serial HCI Sniffing.   
 
This Setup and Quick Start Guide was designed to get you 
up and running quickly with FTS for Bluetooth. It provides a 
high level overview of product installation, initialization, and 
operation. The FTS for Bluetooth interface is easy to use 
without training, but you will want to read the FTS for 
Bluetooth Tutorial and the online Help manual to learn how 
to take maximum advantage of all the features. 
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We have tried to make the online Help complete and easy to 
use.  You can reach the online Help by choosing Help Topics 
from the Help menu, or by pressing the F1 key from any 
window. 
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2 FTS for Bluetooth 
Installation Instructions 

 
2.1 Software Installation 
 
Step 1. 
(Note: If you intend to use FTS for Bluetooth in the air 
sniffing mode, DO NOT plug in the Bluetooth ComProbe 
yet.) Installation should begin when you insert the 
installation CD into your computer.  If it does not, begin 
installing the software by double-clicking on setup.exe on the 
installation CD.  
 
Step 2. 
When prompted, enter your serial number and click Next. 
 
Step 3. 
Please read the license agreement and accept it.  Note, that 
there is a separate license agreement which is required if you 
want to view the source code for the Bluetooth decoders.  If 
you wish to do this, after installation go to the FTS for 
Bluetooth desktop folder and click on Optional Components.  
There will be a shortcut called Decoder Source Code 
License.  Click on it and follow its directions. 
 
Step 4. 
You will need to install the serial driver after the rest of the 
software installation is complete if you intend to use FTS for 
Bluetooth in the Serial HCI sniffing mode. For instructions 
on how to install the serial driver, please go to the FTS for 
Bluetooth folder, then the Setup folder and click on the 
shortcut entitled How to install the FTS Serial driver. 
 
Step 5. 
Take a quick look at the readme file. 
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Step 6. 
If this is the first Frontline Test System product installed on 
your system then accept the reboot option.  If it isn’t, then it 
probably isn’t necessary to reboot (but it won’t hurt to do 
so). 
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2.2 Hardware Installation  
 
2.2.1  Air Sniffing Mode 
 
2.2.1.1  Bluetooth ComProbe Installation 
 
Step 1. 
Plug the Bluetooth ComProbe into a USB port.  After you do 
that you should see a Found New Hardware Wizard dialogue 
box.  Choose Install from a list or specific location and click 
Next.   This process may vary slightly depending on your 
operating system.  The screen shot below is from Windows 
XP. 
 

 
 
Note that if you have already installed a Bluetooth 
ComProbe on your system you might not get the Found New 
Hardware Wizard. You may get this dialog in the future if 
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you plug the Bluetooth ComProbe into a USB port that is 
different than one you have previously used. 
 
Step 2. 
Press the Browse button and browse to the directory where 
you installed FTS for Bluetooth (the default is \Program 
Files\Frontline Test System II\[version #] FTS For 
Bluetooth) and then browse down one more level to 
Bluetooth ComProbe USB Driver. Select this directory and 
click OK.  This directory contains the Bluetooth ComProbe 
USB Driver and the Windows driver information file 
(bluetoothcomprobe.inf) needed to install the driver. 
 
Step 3. 
Click the Next button to finish the Bluetooth ComProbe 
installation. If you get a dialog box like the one below, don’t 
worry—Click Continue Anyway. 
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Step 4. 
Your computer will now install the Bluetooth ComProbe 
driver from the directory you selected; you’ll get a dialog 
box saying that the installation is finished.  Click the Finish 
button to close the wizard. 
 
The installation of the FTS for Bluetooth software and the 
Bluetooth ComProbe hardware is now complete.   
 
Go to Section 3: Using FTS for Bluetooth to find out how to 
begin Air sniffing. 
 
2.2.2  Serial HCI Sniffing Mode 
 
2.2.2.1  Cable Installation 
 
If you don’t have the serial HCI sniffing cables that are 
provided with the full version of FTS for Bluetooth or if 
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those cables are not practical for you to use (for example, if 
you are developing an embedded device) then see the section 
called Connecting Directly to Serial Ports. 
 
The exact details of how to tap the circuit vary widely 
depending on the application or hardware being developed.  
There are two basic methods for feeding signals from the 
circuit into the serial ports of the PC running FTS for 
Bluetooth.  One method uses the cable set provided with FTS 
for Bluetooth and the other sends signals directly to the serial 
ports.  In either case, if the signals coming from the system 
under test are not RS-232, it might be necessary to use a 
converter. 
 
If your Bluetooth Application is running on the PC that is 
running FTS for Bluetooth, an alternative is to run FTS for 
Bluetooth in Spy mode.  Spy monitors data directly from the 
serial port on the PC running the Bluetooth application.  In 
this situation, no cables or converters are needed and no 
extra wiring needs to be done. 
 
It is strongly recommended that you set the Host to be DTE 
and the Host Controller to be DCE; otherwise the Commands 
and Events may be reversed.   
 
2.2.2.2  Connecting Cables to Monitor a 

Circuit 
 
The instructions and diagram below explain how to connect 
the cables to the PC running FTS for Bluetooth and to the 
circuit being monitored.  This information assumes that you 
have two serial ports available on the PC running FTS for 
Bluetooth.  Two serial ports are required in order to see both 
sides of the circuit.  If you have only one serial port, you will 
only be able to monitor one side of the circuit.  See the 
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Online Help under Cable Configuration for instructions on 
setting up the cables with one serial port. 
 

1. Connect the two 9-pin connectors on the Routing 
Cable to the two serial ports on the PC running 
FTS for Bluetooth. 

2. Connect the Monitor Head (beige) to the 25-pin 
connector on the Routing Cable.  The cable set 
includes a beige Monitor Head and a black 
Source Head which look very similar other than 
color; be sure you have the correct cable Head. 

3. Connect the T-connector on the Monitor Head to 
the circuit.  The Monitor Head is a straight-
through connector. Use the adapters provided to 
convert between the 25-pin Monitor Head and 
any 9-pin connections on your circuit. 

 
Click on Hardware Settings and select Use FTS Cables.  
You will also need to select which COM Ports you will be 
using.  
 
Skip to the section called Set I/O Configuration. 
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2.2.2.3  Connecting Directly to Serial Ports 
 
In order for FTS for Bluetooth to correctly capture data when 
not using the cable set, TxD, RxD and Signal Ground need to 
be fed to the proper pins on the serial ports of the PC running 
FTS for Bluetooth.  Note that FTS for Bluetooth will not be 
able to monitor control signals without the cable set. 
 

1. Connect the Serial Data Out of the Host to the 
Serial Data In of the Host Controller.  Connect 
this also to the RxD of the COM Port that will be 
selected in the Upper List Box of the Hardware 
Settings. 

2. Connect the Serial Data In of the Host to the 
Serial Data Out of the Host Controller.  Connect 
this also to the RxD of the COM Port that will be 
selected in the Lower List Box of the Hardware 
Settings. 

3. Connect the Signal Ground of the Host to the 
Signal Ground of the Host Controller and to both 
COM Ports. 

4. Click on Hardware Settings and select Use FTS 
Cables.   

5. Also in Hardware Settings select which COM 
Ports you will be using as directed in steps 1 and 
2.   

6. Disable Notify if Auto Detect Fails.  This will 
prevent FTS for Bluetooth from looking for FTS 
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Cables. 

 
Skip to Section 3: Using FTS for Bluetooth. 

 
 

 
2.2.2.4  Connecting to a Port Using Spy 
 
Important!  In order to monitor an internal port, FTS for 
Bluetooth must be started before the application using the 
port.  This ensures that both FTS for Bluetooth and the 
application use the FTS for Bluetooth serial driver. 
 
The computer running Spy should be the Host talking to the 
external Host Controller. 
 
Click on Hardware Settings and select Spy. You will also 
need to select which COM Ports you will be using. 
 
No special hardware setup needs to be done to monitor an 
internal port.  Skip to the section titled How to Capture Data. 
 
2.2.2.5  Set I/O Configuration 
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Start FTS for Bluetooth in Serial HCI mode by running 
Serial HCI Sniffer (H4), Serial HCI Sniffer (H5) or Serial 
HCI Sniffer (BCSP). 
 
Before you can begin capturing data, you need to tell FTS 
for Bluetooth whether you intend to monitor or transmit data, 
and at what data rate.   You give FTS for Bluetooth this 
information in the Set I/O Configuration window.  Click on 
the Set I/O Configuration icon  on the Control window 
toolbar, or choose Set I/O Configuration from the Window 
menu.  
 

1. In the Operating Mode box, choose Monitor 
Both.  If you have only one serial port, choose 
either Monitor DTE or Monitor DCE, depending 
on which side you want to see. 

2. Set the baud, parity, word length and stop bits to 
the correct settings for both sides of the circuit. 
For Spy, it is not necessary to set these values, as 
the Bluetooth application will do this when it is 
started.  In Spy Mode these boxes automatically 
reflect the values being used by the application. 

3. Click the Close button. 
 
2.2.3  USB HCI Sniffing Mode 
 
The USB HCI Datasource Dialog allows the user to select 
which Bluetooth device to sniff and to initiate and terminate 
the sniffing process.   
 
The dialog has a list containing the Bluetooth Devices 
connected to your system.  If the Show Connected Only 
checkbox is unchecked then all USB devices that have ever 
been connected to your system will be listed. 
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If you have connected or disconnected a device while this 
dialog is open, Click on Refresh List to update the list. 
 
Select the device you wish to sniff then click on the Start 
Sniffing button.  You must click on the Start Capture to 
Buffer or Capture to Disk buttons in FTS to capture data. 
 
Go to section 3: Using FTS for Bluetooth for more details on 
capturing data. 
 
2.2.4  Virtual Sniffing Mode 
 
There is no Hardware Installation necessary for Virtual 
Sniffing.  During the Software Installation a sample Virtual 
Sniffing Application is installed.  To use Virtual Sniffing in 
your environment modify the sample application to import 
data from your software.  For more information please 
consult Tech Support.    
 

3 Using FTS for Bluetooth 
 
The first window to open is the Control Window, which is 
the small rectangular window at the top. FTS for Bluetooth is 
organized around this window.  From the Control window 
you control data capture and have access to the other 
windows used to view data. 
 
3.1 How To Capture Data 
 
3.1.1  Initiating Data Capture in All 

Sniffing Modes 
 
FTS for Bluetooth can capture data to a memory buffer or to 
a file on disk.  Data capture can be initiated from the Control 
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window, the Event Display or the Frame Display. You do 
not need any window other than the Control window open to 
capture data.   
 
To capture to the buffer, click the Start Capture to Buffer 
icon . 
 
To capture to a file, click the Start Capture to Disk icon  
and type a filename when prompted. 
 
To stop capture and reset the buffer, click the Clear icon .  
Clearing the buffer throws away the data in memory.  If you 
want to save the data in the buffer, pause capture (see below) 
and save the buffer before clearing it. 
 
To stop capture to a file and close the file, click the Close 
icon . 
 
To pause capture, click the Pause/Resume icon .  Click 
the Pause/Resume icon again to resume capture.  Pausing 
capture means that no data will be added to the capture 
buffer or file until capture is resumed, but the previously 
captured data remains in the buffer or file. 
 
If the buffer/file becomes full, data capture will begin to 
wrap, which means the oldest data will be overwritten by 
new data. You can tell how full the buffer/file is by checking 
the bar graphic next to Capture Status on the status bar of the 
Control window.  If you do not want the buffer/file to wrap, 
choose System Settings from the Options menu on the 
Control window and uncheck the Wrap Buffer/File box.  If 
you have Wrap Buffer/File unchecked then capturing will 
stop when the buffer/file becomes full. 
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3.1.2  Capturing Data in Air Sniffing 
Mode. 

 
This Quick Start Guide only describes Air Sniffer (Basic).  
You can find more information about the other air sniffing 
modes under the What’s New section in the online Help and 
by calling Tech Support. 
 
There are two steps to capturing data in the FTS for 
Bluetooth Air Sniffing mode.  The first is initiating data 
capture (see previous section), and the second is 
synchronizing the Bluetooth ComProbe to the Bluetooth 
piconet.  Data capture is initiated via the Control window, as 
explained in the previous section. We recommend beginning 
data capture before synchronizing the ComProbe so that 
when data begins arriving,  FTS for Bluetooth is ready to 
capture it. 
 
3.1.2.1  Synchronizing to the Piconet 
 
Step 1 - Connect the ComProbe 
Make sure the Bluetooth ComProbe is connected to a USB 
port. 
 
Step 2 - Start Air Sniffer 
Open the FTS for Bluetooth folder on your desktop and 
double-click Air Sniffer (Basic).  This will cause FTS for 
Bluetooth to start and the Bluetooth ComProbe icon to 
appear in your system tray in red with a line through it. Also, 
the Datasource dialog box will appear. 
 
Step 3 - Select a ComProbe Device 
If you have multiple Bluetooth ComProbes installed then 
you will need to click the Hardware Settings button on the 
Datasource dialog to pick which one you want to use.   
 



 16 

Step 4 - Synchronization 
You must next tell FTS for Bluetooth which synchronization 
mode to use.  Click the I/O Parameters button on the 
Datasource dialog. 
 
At the top of the Set I/O window, choose a synchronization 
mode.  The preferred mode is Slave Inquiry.  In this mode, 
FTS for Bluetooth asks the slave device for its clock and 
then waits for the master to page the slave.   
 
In Bluetooth, the device that initiates the connection is 
always the master at connection time. You only need to 
know the master and slave at connection time when setting 
up the I/O parameters.  Afterwards a role switch may occur, 
but FTS for Bluetooth will automatically follow the role 
switch. 
 
The rest of these instructions assume you have selected Slave 
Inquiry mode. For more information on the other 
synchronization modes, see the online Help.   
 
Enter in the Slave Device box the Bluetooth Device Address 
of the slave device that FTS for Bluetooth should sync to.  If 
you know the device address, you can simply enter it using 
the 12 hex digits box or UAP, LAP and NAP.  Otherwise, 
click the Discover Bluetooth Devices button and then select 
the correct device from the drop-down list.  You may wish to 
specify a Master Device as well if you want to be certain of 
monitoring a specific piconet. 
 
If you are sniffing an encrypted session, you must set the 
encryption settings correctly.  For the details on these 
settings consult the Encryption topic in the online Help. 
 
Finally, there are some optional settings for capture filtering 
and for using inquiry access codes to limit the list of devices 
returned when Discover Bluetooth Devices is clicked.  See 
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the information on the Set I/O Parameters window in the 
online Help if you wish to change these settings. 
 
Click OK when finished. 
 
3.1.2.2  Piconet Synchronization State 
 
As data is being captured, the Status box at the top of the 
Datasource dialog will update to show the piconet 
synchronization status of the Bluetooth ComProbe. 
 
You will also note that the color of the Bluetooth ComProbe 
icon in the system tray and in the Status box will vary in 
color depending on the state of the Bluetooth ComProbe:   
 

• Blue indicates that the Bluetooth ComProbe is 
running and in sync with the piconet.   

• Green indicates that the Bluetooth ComProbe is 
running and waiting to synchronize.   

• Yellow indicates that the Bluetooth ComProbe will 
attempt to resynchronize within 5 seconds,  

• Red indicates that the Bluetooth ComProbe is 
attempting to synchronize, 

• Red with a “Not” symbol means the Bluetooth 
ComProbe is stopped. 

 
Typically, you can focus your attention on the  FTS for 
Bluetooth data displays and not worry about the Bluetooth 
ComProbe.  But if you aren’t seeing data when you think 
you should, then check the Datasource dialog. 
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3.2  Looking At Frames 
 
3.2.1  Protocol Navigator 
 
Click the Protocol Navigator icon  on the Control 
window toolbar to open the Protocol Navigator. The Protocol 
Navigator window presents decodes of multiple protocol 
layers within multiple data frames. It simplifies the process 
of understanding the complex relationships between multiple 
data frames and the protocol layers that comprise the frames. 
The three window panes on the left of the Protocol Navigator 
enable you to select or suppress protocols of interest. 
 
3.2.1.1  Hiding and Revealing Protocols 
 
Hiding means that the selected protocol is not displayed in 
the main window pane, even though it may be present in a 
frame.  This allows you to zoom in on protocols of interest 
by hiding all of the ones that aren’t of interest. 
 
There are two ways to hide a protocol in the Protocol 
Navigator window. 
 

1. Right-click on the protocol and choose Hide 
[Protocol Layer Name]. 

 
2. There are three panes on the left side of the 

window.  The middle box is the Hidden From 
View pane.  Check the boxes next to the 
protocols you want to hide. 

 
To reveal a hidden protocol, right-click anywhere in the 
main window and select the protocol you want to show from 
the right-click menu, or uncheck the box next to the protocol 
name in the Hidden From View pane. 
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When one or more layers are hidden, a note will appear at 
the top of the Protocol Navigator saying, "Some layers are 
hidden. Right-click to see."  This warns you that some layers 
are hidden. 
 
Two special options are All But the Last Layer and All 
Special Information Nodes. 
 
All But the Last Layer hides all layers in each frame except 
for the last one, regardless of which protocol is present in the 
last layer. 
 
3.2.1.2  Filtering on a Protocol Layer 
 
Note: Changes to filtering will affect the Frame Display and 
Protocol Navigator. 
 
You can filter on one or more protocol layers by using the 
top window pane, the Filtered In pane. Check the boxes next 
to the names of the protocols you want to filter in. The filter 
is inclusive, which means that filtering on a protocol displays 
only frames that contain that protocol.  Frames that do not 
contain the protocol will not appear.  You can filter on one or 
more protocols.  
 
3.2.1.3  Using Named Filters 
 
FTS for Bluetooth comes with many predefined Named 
Filters.  You can apply one or more of these filters by 
checking the boxes next to the names of the filters you want 
to use.  If you want to create your own filters please consult 
the online Help under Filtering. 
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3.2.2  Frame Display 
Click the Frame Display icon  on the Control window 
toolbar to open the Frame Display.  This display allows you 
to have bit level visibility on your protocol.   
 
3.2.2.1  Panes 
 
The Frame Display is divided into panes, where each pane 
shows a different view of the data.  The Summary pane 
stretches across the top of the display.  Each line in the 
Summary Pane represents one frame.  The Decode pane 
contains a detailed decode of the frame selected in the 
Summary pane, and is located on the left side of the Frame 
Display window.  The three smaller panes on the bottom 
right of the Frame Display show the data in hex, binary and 
ASCII.  The user can choose to have these panes show the 
data in other radixes or character sets.  Select any field in the 
Decode pane and the corresponding bit(s) or byte(s) will be 
selected in the data panes. 
 
3.2.2.2  Frame Errors 
 
Frame numbers in red indicate an error in the frame.  Select 
the frame, and look at the top of the Decode pane to 
determine the type of error. 
 
3.2.2.3  Searching 
 
Use the Find feature to search for a pattern in the decode or 

errors in the frames.  Click the Find icon  to open the 
Find window.  In the Decode tab, type the string you want to 
look for and click Find Next.  To search for errors, choose 
Search For All Errors.  Click the Help button for more 
information. 
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The Duplicate icon  creates a second Frame Display, 
identical to the first.  The advantage of additional Frame 
Displays is that you can look at two different frames at the 
same time and they can be filtered differently. 
 
3.2.2.4  Viewing Frames Live 
 
Click the Freeze/Resume icon  to toggle between having 
the Summary pane automatically update or not update as 
new data is captured.  
 
3.2.2.5  Display Synchronization 
 
The Frame Display is synchronized with the Event Display 
and Protocol Navigator.  Select a frame in the Frame Display 
and the Protocol Navigator and Event Display will 
automatically update to highlight the bytes in the frame.  
Select a byte in the Event Display or Protocol Navigator, and 
the Frame Display will update to show the frame containing 
the byte, with the byte highlighted. 
 
 
3.3 Statistics 
 
Click the Statistics icon  on the Control window toolbar 
to open the Statistics window. 
 
The Statistics window provides a statistical overview of all 
the data on the circuit.  In Serial HCI Sniffing mode, FTS for 
Bluetooth is always monitoring the circuit and gathering 
statistics, even when it is not capturing the data.  In the Air 
Sniffing Mode FTS for Bluetooth only gathers statistics 
when it is synchronized with the piconet. 
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There are three tabs on the Statistics window: Session, 
Resetable and Buffer.  The Session tab shows statistics from 
the time FTS for Bluetooth was started.  The Resetable tab 
can be reset to show statistics from the time the Reset icon 
was last pressed.  The Buffer tab shows statistics on the data 
in the capture buffer.  If data capture has not been started or 
if the buffer has wrapped, most of the statistics on the Buffer 
tab will be “n/a”. 
 
Some tables on the Statistics window can display data in 
graphic form.  Click the Graph icon  on any header that 
has one for a chart of that table. 
 
The Frame Status Table can be useful for determining where 
to place the Bluetooth ComProbe.  The different statistics in 
the table are defined as follows. 
 

• Bad - Number of Frames that FTS for Bluetooth 
receives damaged at the RF level. 

• Retransmitted - Number of Frames that FTS for 
Bluetooth receives undamaged at the RF level but 
that a piconet member receives damaged at the RF 
level and therefore get retransmitted. 

• Ratio - This number is derived from the Bad and 
Retransmitted statistics which will give you 
information on Bluetooth ComProbe placement.  If 
the ratio is 0 then both Bad and Retransmitted frames 
are 0.  If the number is positive then there are more 
bad frames than retransmitted frames.  If this number 
is large you may want to move the Bluetooth 
ComProbe to get a better signal.  If the number is 
negative then there are more retransmitted frames 
than bad frames.  If this number is a large negative 
number it means that the Bluetooth ComProbe is 
picking up the RF signal better than the members of 
the piconet. 
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3.4 Additional Displays 
 
There are additional displays that may be of value to those 
doing serial HCI sniffing.  
 
The Event Display  can be used to see the data 
transferred between a Host and a Host Controller before the 
data is decoded. Communications errors on the serial data 
circuit, such as overrun, framing, and parity can only be seen 
on the Event Display. The Event Display shows where each 
frame begins and ends. This can be helpful when diagnosing 
transport synchronization problems.  
 
When a transport such as HCI UART (H4) uses hardware 
flow control, the Breakout Box  and Signal Display  
windows can be used to help diagnose problems with missed 
messages and data overruns. 
 
3.5 Exiting FTS for Bluetooth 
 
To exit FTS for Bluetooth: 
 
Go to the File menu on the Control window, and choose Exit 
FTS for Bluetooth, or close the Control window using the X 
icon in the top right corner of the title bar. 
 
If you are in Air Sniffing mode you will also need to close 
the Datasource by choosing Terminate from the File Menu 
on the Datasource or using the X icon in the top right corner.  
 
 
Technical Support 
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Technical support is available in several ways.  The answers 
to many questions can be found in the online help.  
Frontline’s web site has documentation on common 
problems, as well as software upgrades and utilities to use 
with our products. 
 
Web: http://www.fte.com, go to the Technical Support 
Area 
Email: tech_support@fte.com 
FTP: ftp.fte.com 
 
If you need to talk to a technical support representative, 
support is available between 9am and 5pm, Eastern time 
(GMT-5:00), Monday through Friday.  Technical support is 
not available on U.S. national holidays. 
 
Phone: +1 (434) 984-4500 
Fax: +1 (434) 984-4505 
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